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Chapter 1

VC7203 IBERT Getting Started Guide

Overview

This document provides a procedure for setting up the VC7203 Virtex®-7 FPGA GTX
Transceiver Characterization Board to run the Integrated Bit Error Ratio Test (IBERT)
demonstration using the Vivado® Design Suite. The designs that are required to run the
IBERT demonstration are stored in a Secure Digital (SD) memory card that is provided
with the VC7203 board. The demonstration shows the capabilities of the Virtex-7
XC7VX485T FPGA GTX transceiver.

The VC7203 board is described in detail in VC7203 Virtex-7 FPGA GTX Transceiver
Characterization Board User Guide (UG957) [Ref 1].

The IBERT demonstrations operate one GTX Quad at a time. The procedure consists of:
Setting Up the VC7203 Board, page 8

Extracting the Project Files, page 9

Connecting the GTX Transceivers and Reference Clocks, page 10

Configuring the FPGA, page 15

Setting Up the Vivado Design Suite, page 16

Starting the SuperClock-2 Module, page 19

Viewing GTX Transceiver Operation, page 25

® Nk » D=

Closing the IBERT Demonstration, page 26
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Chapter 1: VC7203 IBERT Getting Started Guide & XILINX.

Requirements

The hardware and software required to run the GTX IBERT demonstrations are:

VC7203 Virtex-7 FPGA GTX Transceiver Characterization Board including:

One SD card containing the IBERT demonstration designs
One Samtec BullsEye cable

Eight SMA female-to-female (F-F) adapters

Six 50Q2 SMA terminators

GTX transceiver power supply module (installed on board)
SuperClock-2 module, Rev 1.0 (installed on board)

12V DC power adapter

USB cable, standard-A plug to Micro-B plug

Host PC with:

SD card reader
USB ports

Vivado Design Suite software 2014.4

The hardware and software required to rebuild the IBERT demonstration designs are:

PC with a version of the Windows operating system supported by Xilinx Vivado
Design Suite

Vivado Design Suite software 2014.4

Setting Up the VC7203 Board

This section describes how to set up the VC7203 board.

1.

Caution! The VC7203 board can be damaged by electrostatic discharge (ESD). Follow
standard ESD prevention measures when handling the board.

When the VC7203 board ships from the factory, it is configured for the GTX IBERT
demonstrations described in this document. If the board has been re-configured it must be
returned to the default setup before running the IBERT demonstrations.

Move all jumpers and switches to their default positions. The default jumper and
switch positions are listed in VC7203 Virtex-7 FPGA GTX Transceiver Characterization
Board User Guide (UG957) [Ref 1].

Install the GTX transceiver power module by plugging it into connectors J66 and J97.
Install the SuperClock-2 module:

a.

b.

Align the three metal standoffs on the bottom side of the module with the three
mounting holes in the SUPERCLOCK-2 MODULE interface of the VC7203 board.

Using three 4-40 x 0.25 inch screws, firmly screw down the module from the
bottom of the VC7203 board.

On the SuperClock-2 module, place a jumper across pins 2-3 (2V5) of the
CONTROL VOLTAGE header, J18, and place another jumper across 51570 INH
header J11.

Screw down a 50Q2 SMA terminator onto each of the six unused Si5368 clock
output SMA connectors: J7, J8, J12, J15, J16 and J17.
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Extracting the Project Files

Extracting the Project Files

The Vivado project files required to run the IBERT demonstrations are located in
rdf0272-vc7203-ibert-2014-4.zip on the SD card provided with the VC7203
board. They are also available online at the Virtex-7 FPGA VC7203 Characterization Kit

documentation website.

The ZIP file contains these files:

e BIT files
ve7203_ibert_gll3_152.bit

ve7203_ibert_gll4d_152.bit
ve7203_ibert_gll5_152.bit
ve7203_ibert_gll6e_152.bit
ve7203_ibert_gll7_152.bit
ve7203_ibert_gll8_152.bit
ve7203_ibert_gll9_152.bit

e Probe files

vc7203_ibert_113_debug_nets.
vc7203_ibert_114_debug_nets.
vc7203_ibert_115_debug_nets.
vc7203_ibert_116_debug_nets.
vc7203_ibert_117_debug_nets.
vc7203_ibert_118_debug_nets.

vc7203_ibert_119_debug_nets.

e Tcl scripts
add_scm2.tcl

setup_scm2_156_25.tcl

ltx
ltx
ltx
ltx
ltx
ltx

1ltx

The Tcl scripts are used to help merge the IBERT and SuperClock-2 source code (described
in Creating the GTX IBERT Core, page 28) and to set up the SuperClock-2 module to run at
156.25 MHz (described in Setting Up the Vivado Design Suite, page 16). The debug probes
are used by Vivado design tools to properly load the SuperClock-2 VIO core.

To copy the files from the Secure Digital memory card:

1. Connect the Secure Digital memory card to the host computer.
2. Locate the file rd£0272-vc7203-ibert-2014-4. zip on the Secure Digital

memory card.

3. Unzip the files to a working directory on the host computer.
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Chapter 1: VC7203 IBERT Getting Started Guide & XILINX.

Running the GTX IBERT Demonstration

The GTX IBERT demonstration operates one GTX Quad at a time. This section describes
how to test GTX Quad 115. The remaining GTX Quads are tested following a similar series
of steps.

Connecting the GTX Transceivers and Reference Clocks

Figure 1-1 shows the locations for GTX transceiver Quads 113, 114, 115, 116, 117, 118, and
119 on the VC7203 board.

Note: Figure 1-1 is for reference only and might not reflect the current revision of the board.
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Figure 1-1: GTX Quad Locations
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Running the GTX IBERT Demonstration

All GTX transceiver pins and reference clock pins are routed from the FPGA to a connector
pad which interfaces with Samtec BullsEye connectors. Figure 1-2 A shows the connector
pad. Figure 1-2 B shows the connector pinout.

GTX Connector Pad

GTX Connector Pinout

UG847_c1_02_100813

Figure 1-2: A - GTX Connector Pad. B - GTX Connector Pinout

The SuperClock-2 module provides LVDS clock outputs for the GTX transceiver reference
clocks in the IBERT demonstrations. Figure 1-3 shows the locations of the differential clock
SMA connectors on the clock module which can be connected to the reference clock cables.

Note: The image in Figure 1-3 is for reference only and might not reflect the current revision of the
board.

¢ h g g
GND ||CLKOUT_2 ' ICLKOUT_3 LE(!UIJ

| 2
(CLKOUTZ_I\D/ (CLkouT3_N) \(CLKOUT4_@

UG847_c1_03_102213

S1570_CLK_N CLKOUT1_N

Figure 1-3: SuperClock-2 Module Output Clock SMA Locations

The four SMA pairs labeled CLKOUT provide LVDS clock outputs from the Si5368 clock
multiplier /jitter attenuator device on the clock module. The SMA pair labeled Si570_CLK
provides LVDS clock output from the Si570 programmable oscillator on the clock module.

Note: The Si570 oscillator does not support LVDS output on the Rev B and earlier revisions of the
SuperClock-2 module.

For the GTX IBERT demonstration, the output clock frequencies are preset to 156.25 MHz.
For more information regarding the SuperClock-2 module, see HW-CLK-101-SCLK2
SuperClock-2 Module User Guide (UG770) [Ref 2].
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Chapter 1: VC7203 IBERT Getting Started Guide & XILINX.

Attach the GTX Quad Connector

Before connecting the BullsEye cable assembly to the board, firmly secure the blue
elastomer seal provided with the cable assembly to the bottom of the connector housing if
it is not already inserted (see Figure 1-4).

Note: Figure 1-4 is for reference only and might not reflect the current version of the connector.

UGB47_c1_04_100813

Figure 1-4: BullsEye Connector with Elastomer Seal

Attach the Samtec BullsEye connector to GTX Quad 115 (Figure 1-5), aligning the two
indexing pins on the bottom of the connector with the guide holes on the board. Hold the
connector flush with the board and fasten it by tightening the two captive screws.

UGB47_c1_05_031014

Figure 1-5: BullsEye Connector Attached to Quad 115
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GTX Transceiver Clock Connections

See Figure 1-2 to identify the P and N coax cables that are connected to the CLK1 reference
clock inputs. Connect these cables to the SuperClock-2 module as follows:

e CLK1_P coax cable - SMA connector J5 (CLKOUT1_P) on the SuperClock-2 module

¢ CLK1_N coax cable - SMA connector J6 (CLKOUT1_N) on the SuperClock-2
module

Note: Any one of the five differential outputs from the SuperClock-2 module can be used to source
the GTX reference clock. CLKOUT1_P and CLKOUT1_N are used here as an example.

GTX TX/RX Loopback Connections

See Figure 1-2 to identify the P and N coax cables that are connected to the four receivers
(RX0, RX1, RX2 and RX3) and the four transmitters (TX0, TX1, TX2 and TX3). Use eight
SMA female-to-female (F-F) adapters (Figure 1-6), to connect the transmit and receive
cables as shown in Figure 1-7 and detailed here:

e TX0_P— SMA F-F Adapter —» RX0_P
e TXO0_N — SMA F-F Adapter - RX0_N
e TX1_P— SMA F-F Adapter —» RX1_P
e TX1_N — SMA F-F Adapter » RX1_N
e TX2 P — SMA F-F Adapter » RX2_P
e TX2_N — SMA F-F Adapter » RX2_N
e TX3_P— SMA F-F Adapter - RX3_P
e TX3_N — SMA F-F Adapter - RX3_N

Note: To ensure good connectivity, it is recommended that the adapters be secured with a wrench;
however, do not over-tighten the SMAs.

3 i

UG847_c1_06_100813

Figure 1-6: SMA F-F Adapter
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Chapter 1: VC7203 IBERT Getting Started Guide & XILINX.

TX Coax

SMA F-F Adapter
/_ RX Coax
) : r:’.:) . p

A\
y

UG847_c1_07_031714
Figure 1-7: TX-to-RX Loopback Connection Example

Figure 1-8 shows the VC7203 board with the cable connections required for the Quad 115
GTX IBERT demonstration.

QUAD 115 CLKOUT_1N
- CLKOUT_1P

XNIIX

TX/RX Loopback
Connections

UGB847_c1_08_030414

Figure 1-8: Cable Connections for Quad 115 GTX IBERT Demonstration
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Configuring the FPGA

This section describes how to configure the FPGA using the SD card included with the
board. The FPGA can also be configured through the Vivado Design Suite software using
the .bit files and .1tx probe files available on the SD card, or online (as collection
rdf0272-vc7203-ibert-2014-4. z1ip) at the Virtex-7 FPGA VC7203 Characterization
Kit documentation website.

To configure from the SD card:

1. Insertthe SD card provided with the VC7203 board into the SD card reader slot located
on the bottom-side (upper-right corner) of the VC7203 board.

Plug the 12V output from the power adapter into connector ]2 on the VC7203 board.

Connect the host computer to the VC7203 board using a standard-A plug to Micro-B
plug USB cable. The standard-A plug connects to a USB port on the host computer and
the Micro-B plug connects to U8, the Digilent USB JTAG configuration port on the
VC7203 board.

4. Select the GTX IBERT demonstration with the System ACE™ SD controller SYSACE-2
CFG switch, SW8. The setting on this 4-bit DIP switch (Figure 1-9) selects the file used
to configure the FPGA. A switch is in the ON position if set to the far right and in the
OFF position if set to the far left. For the Quad 115 GTX IBERT demonstration, set
ADR?2 = ON, ADR1 = OFF, and ADRO = ON. The MODE bit (switch position 4) is not
used and can be set either ON or OFF.

SYSACE-2 CFG
Sw8
ADRO
ADR1
ADR2
MODE

UG847_c1_09_110112

Figure 1-9: Configuration Address DIP Switch (SW8)

There is one IBERT demonstration design for each GTX Quad on the VC7203 board, for a
total of seven IBERT designs. An additional design is provided to demonstrate the
USB/UART interface (details of this demonstration are described in the README file on the
SD card). All eight designs are organized and stored on the SD card as shown in Table 1-1.

Table 1-1: SD Card Contents and Configuration Addresses

Dem;:;gztm" ADR2 ADR1 ADRO
GTX Quad 113 ON ON ON
GTX Quad 114 ON ON OFF
GTX Quad 115 ON OFF ON
GTX Quad 116 ON OFF OFF
GTX Quad 117 OFF ON ON
GTX Quad 118 OFF ON OFF
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Chapter 1: VC7203 IBERT Getting Started Guide & XILINX.

Table 1-1: SD Card Contents and Configuration Addresses (Cont’d)

Demonstration ADR2 ADR1 ADRO
Design
GTX Quad 119 OFF OFF ON
LED Scroll OFF OFF OFF

5. Place the main power switch SW1 to the ON position.

Setting Up the Vivado Design Suite

1. Start Vivado Design Suite on the host computer and click Flow > Open Hardware
Manager (highlighted in Figure 1-10).

File | Flow | Tools Window Help
<| ¥ Open Hardware Manager i
4 §
VIVADO | ~ XILINX
. Productivity. Multiplied ALL PROGRAMMABLE.
Quick Start
AF j |
\ =3
Create New Project Open Project ©Open Example Project
Tasks
% ®
= )
Manage [P Open Hardware Manager Xilinx Td Store
»

Information Center

9 B

Documentation and Tutorials Quick Take Videos Release Motes Guide

= Td Console
UG847_c1_10_090914

Figure 1-10: Vivado Design Suite, Open Hardware Manager
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2. In the Hardware Manager window, click Open target, and select the Open New
Target option (highlighted in Figure 1-11).

Hardware Manager - unconnected

m Mo hardware target is open. IDEH Iﬁrgetl

Hardware % Auto Connect

= =El EH '.l » . Recent Targets

Closed Targets
Mame
i Open Mew Target...
4| 1 L =
Properties — O 2 =

+« -5 x

ug847_c1_11_102914

Figure 1-11: Open a New Hardware Target

3. An Open Hardware Target wizard pops up. Click Next on the first window.

4. In the Hardware Server Settings window, select Local server (target is on local
machine). Click Next to open the server and connect to the Xilinx TCF JTAG cable.
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5. In the Select Hardware Target window, the Xilinx_tcf cable appears under Hardware
Targets, and the JTAG chain contents of the selected cable appear under Hardware
Devices (Figure 1-12). Select the Xilinx_tcf target and keep the JTAG Clock Frequency
at the default value (15 MHz). Click Next.

ﬂ, Open Mew Hardware Target \E\
Select Hardware Target
Select a hardware target from the list of available targets, then set the appropriate JTAG dock (TCK) '
frequency. If you do not see the expected devices, decrease the frequency or select a different target.
Hardware Targets
Type Port  Mame JTAG Clock Frequency

Hardware Devices (for unknown devices, specify the Instruction Register (IR) length)

MName ID Code IR Length

G system_ace_cf 0 0ADD1093 8
@ xcTvx485t 1 33687093 6

Hardware server: localhost: 3121

[ < Back ]| Mext > | Finish

UG847_c1_12_051314

Figure 1-12: Select Hardware Target

6. Inthe Open Hardware Target Summary window, click Finish. The wizard closes and
the Vivado tool opens the hardware target.
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& XILINX. Running the GTX IBERT Demonstration

Starting the SuperClock-2 Module

The IBERT demonstration designs use an integrated VIO core to control the clocks on the
SuperClock-2 module. The SuperClock-2 module features two clock-source components:

¢ Always-on Si570 crystal oscillator

e S5i5368 jitter-attenuating clock multiplier.

Outputs from either device can be used to drive the transceiver reference clocks.
To start the SuperClock-2 module:

1. The Vivado Design Suite Hardware window shows the System ACE controller and the
XC7VX485T device. The XC7VX485T device is reported as programmed. In the
Hardware Device Properties window, enter the file path to the Q115 Probes file
(ve7203_ibert_gll5_debug_nets.1ltx) in the extracted IBERT files from the SD
card (Figure 1-13).

Hardware — O 2 = Debug Probes — O 2 =
ol E ] Ol e =

o SEEE v »E QI 5|E

Mame Status

E- B localhaost (1) Connected
= @ wilinx_tcf/Digilent/2102518097...  Open

Lol eweham =es 0 Flrt mrmar=mm e, A

| 5 xcTwcA85t_1 (2) (active)

Hardware Device Froperties — O = To populate Probes
« = &5
@ xcTvxaB5t_1

IR Tength: [] "

I= programmable

Programming file: [3
I Probes file: [ I

o] T T

‘ User chain count: 4

General | Properties

UG847_c1_13_030314

Figure 1-13: Adding the Probes File
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2. In the Hardware window, right-click XC7VX485T_1 and select Refresh Device
(Figure 1-14).

Note: If the FPGA was not programmed using the SD card, provide both the programming and
the probes files, and then select Program Device.

Hardware B T 4 Debug Probes _ O =
A i E ] Al i E
az=EEM»E QT=[E
Name Status
- § locahost (1) Connected =
=@l wline_tef/Digilent/210251809763 (2)  Open A
o gystem ace of 0(0) Not programm
B scTvidB5t_1 (2) (active)
-3 [BERT { [ Hardware Device Properties... Ctrl+E
4 i b :
[ — | [ i@ Program Device...
Hardware Device Properties — O 1* ¥|& Refresh Device
€9 &}l Di & Add Configuration Memory Device..
® xcrvxdgst 1 Export to Spreadsheet...
IR length: [ L

Is programmable

Programming file: E] A
Probes file: debug_nets. lx E] 4
| User chain count: 4 =

Praperties |

UGB47_c1_14_031014

Figure 1-14: Program/Refresh Device
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& XILINX.

Running the GTX IBERT Demonstration

3. The Vivado tool now shows the SuperClock-2 VIO core and the IBERT core. To
configure the SuperClock-2 module, select Tools > Run Tcl Script (Figure 1-15). In the
following Run Script window, navigate to the setup_scm2_156_25. tcl script in
the extracted files and click OK.

File Edit Flow | Tools | Window Layout Wiew Help
& | Report P e R ®
|m &  Create and Package IP...
(@) There are no Bun Td Script...
& Property Editor Ctrl+)
Hardware Associate ELF Fles... bug Probes N o T
Compile Simulation Libraries. ..
EE hw_vio_1 -
ame | B OpenNew Target... b _scm2fu_vio_sclk2_controlfi2e_ack I
= E Incalho.s.t & Open Recent Target L4 e u_scm2fu_vio_sclk2_control/i2c_done
-l xinx_{ Program Device y | Big u_som2fu_vio_sdk2_controlfi2c_rd_data[7:0]
Add Configuration Memory Device » g Ll_scmHu_v?n_sdkZ_CDntrnlfpcaEI_tt'I [5:0]
- i u_scm2fu_vio_sdk2_controlfpcal_ctrl[S:0]
Open Hardware Dashboard b | @i u_scm2fu_vio_sdk2_control/sdk_in[3:0]
-8 u_scm2fu_vio_sdk?_controlfsdk_out_w[5:0] =
e u_scm2fu_vio_sclk2_control/si5368_done
-8 u_scm2fu_vio_sdk2_controlfsi5368_freg[19:0]
Hardware Device H = - u_scm2fu_vio_sck2_control/siS70_done
- ¥ilinx Tcl Store... i u_scm2fu_vio_sck2_control/sis70_freq[15:0]
=+ Eﬁ [}{ - -85 u_scm2fu_vio_sdk2_controlfiZc_dev_addr[7:0]
@ xcTvn4a5t_1 e b - u_scm2fu_vio_sclk2_controlfi2c_noreg |
& Options... 45 u_scm2fu_vio_sdk2_controlfiZc_reg_addr[7:0]
MName: XCTvKFBET_1 Tl g u_scm2fu_vio_sdk2_control/i2c_start
Part: X745t o kg u_scm2fu_vio_sdk2_controlfiZc_wr_data[7:0]
[#%g u_scm2fu_vio_sck?2_control/pca0_ctrl_1[5:0]
e BT - (g u_scm2fu_vio_sdk2_controlfpcal_ctrl_1[5:0]
4 | mn | - u_scm2fu_vio_sclk2_control/sck2_reset
General | Properties 15 u_scm2fu_vio_sdk?_controlfsdk_out_w_1[5:0]
o i Tl =l I ] ] Ade T 01

UG847_c1_15_051314

Figure 1-15: Run Tcl Script
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4. To view the SuperClock 2 settings in the VIO core, select the probe signal from the
Debug Probes window and drag it to the VIO window. For example, the frequencies,
ROM addresses, and start signals are selected from Figure 1-16.

Note: The ROM address values for the Si5368 and Si570 devices (that is, si5368_addr[6:0]
and si570_addr[6:0]) are preset to 60 to produce an output frequency of 156.250 MHz. Entering
a different ROM address changes the reference clock(s) frequency. The complete list of
pre-programmed SuperClock-2 frequencies and their associated ROM addresses is provided in
Table 1-2, page 26.

Debug Probes I T J@wo-hw_vin_l X [
Ck Z %. E VIO Probes a0 =
[ u scmeu vio sdkz conh’ol,{sdk out[S D] - % C\ Mame Value Activity Direction VIO

= B u_scm2fu_vio_sck?_control/si5368_freq[19:0] |[U] 156250
E u_scm2fu_vio_sck?_control/si570_freq[19:0] |[U] 156250

— u_scm2fu_vio_sck2_control/si5368_addr[6:0] |[U] &0
E \ u_scm2fu_vio_sck?_control/si570_addr [6:0]

g U _vio_: i scm2fu_vio_sck2_control/si5368_start

-lg u_scm2fu_vio_sdk2 conh’olflﬁ: _noreg \u.

H-£g u_scm2fu_vio_sdk2_controlfi2c_reg_addr[7:0]
-lg u_scm2fu_vio_sdk2_controlfi2c_start

i u_scm2/u_vio_scdk2_contralfizc_wr_data[7:0] i - The Frequency for both clocks is set to 156.25 MHz
H-E5 u_sem2fu_vio_sck2_controlfpea_ctrl_1[5:0] ;
t-k5 u_scm2fu_vio_sck2_controlfpcal_ctrl_1[5:0]
g u_scm2fu_s vio _sclk2_controlfschk?_reset

- The ROM address value for both clocks is set to
60 (156.25MHz)

\

AR=—Ru_scm2fu_vio_sdk2_control/si5368._; addr[b 0]

-la U scmzfu wio sdkz _control/si5368_ dku\r
th-£g u_scm2fu_vio_sdk2_control/si5368 _dsbl[4:0]
<oy somy vin selk? control/SS36R reset i

AN

s lu scm2fu vio sdk2 controlfsi53e8 start

AESQu_scm2ju_vio_sdk?_controlfsi570_addr[6:0]

/ / - 5i5368 and Si570 start buttons (clock starts on rising edge)

tHEF U 5C|T|£‘|'LI WD _SClkd, CDHU'DI;ISIEFU s [0 = HA) /

--1g I} ..cm2}u ] ..de conh'olf.,lm start

UGB47_c1_16_031714

Figure 1-16: SuperClock-2 Module VIO Core
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& XILINX.

Running the GTX IBERT Demonstration

5. To view the GTX transceiver operation, click Layout > Serial I/O Analyzer. From the
top of the Hardware Manager window, select Auto-detect Links to display all
available links automatically. Links can also be created manually in the Links window
by right-clicking and selecting Create Links, or by clicking the Create Links button

(Figure 1-17).

| Hardware Manager - localhostfxilim_tcf(Digilent/210251809763

@ There are no serial 1fO Iinks.l Auto-detect links Create links I

Hardware S I T 4 Debug Probes — O =
G pig = ] g =
Q < = [EFd vl » | az=E
Mame Status -3 hw_via_1 o
=& IBERT (IBERT) - u_scm2fu_vio_sdk2_controlfi2c_ack
1] -
= Qu.;d 113‘ e - _scm2fu_vio_sck?2_controlfi2c_done
‘.- [l COMMON_X1YD Locked g u_scmzfu_v!o_sgti_conzo:ﬁk_lgd_:—.lat;[D?:D]
By MGT_X1Y0 12,500 Ghps i 1 u_sem2/u_vio_s dkz_contolfpcal_ctl[s:ol
By MET_X1¥1 12,500 Ghps : Hig u_su‘nzfu_v!o_s _control/pca __c [5:0]
By MGT X1v2 12.500 Ghps #i u_scm2ju_vio_sck2_controlfsck_in[g:0]
. B2y MGT_X1Y3 12,500 Gbps = -8 u_scm2J’u_v!o_sde_controIfst_out_w[S:D] 2
@ b vio 1(/10) oKk = - U_scm2fu_vio_sclk2_control/si5368_done
R H [#i5 u_scm2ju_vio_sck?2_control/si5368_freq[19:0]
Hardware Device Properties _ 0O, = -z u_stm2fu_vio_sck2_control/si570_done
; -8 u_scm2fu_vio_sdk2_controlfsi570_freq[19:0]
5 Q k5 u_scm2fu_vio_sdk2_controlfi2c_dev_addr[7:0]
@ xcTux4B5t_1 ~a W_scm2fu_vio_schk2_controlfi2c_noreg |4
" g u_scm2ju_vio_sdk2_controlfi2c_reg_addr[7:0]
Mame: xcTvn4ast_1 m -a u_scm2fu_vio_sdk2_controlfi2c_start
Part: s _ [#g u_scm2ju_vio_sck?2_controlfi2c_wr_data[7:0]
g u_scm2ju_vio_sdk2_controlfpca0_ctrl_1[5:0]
LG 33687053 - [#-&5 u_scm2fu_vio_sdk2_controlfpcal_ctrl_1[5:0]
1| L) J S g u_scm2fu_vio_sdk2_control/zdk2_reset
Properties | [#5 u_scm2ju_vio_sck2_controlfsck_out_w_1[5:0]
oo i a 11 i e el fni B Ade T 11
Serial I/ Links
O\ MName T RXx Status Bits Errors BER BERT Reset TX Pattern
e
L B Properties Ctrl+E
i
¥ Delete Delete
%% Create Links...
& Create Link Group Auto-detect links or create links Jto add serial IjO li
& B Createsce
E B C Sweep
B Commit Properties
@ e @ Refresh Serial I/O Cbjects -
= Td Console Export to Spreadsheet. .. I8l 1/0 Scans J

UGB47_c1_17_051314

Figure 1-17: Serial /O Analyzer - Create Links
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6. Iflinks are created manually, the Create Links window is displayed. The options in this
window are used to link any TX GT to any RX GT. To create links, select the TX GT and
RX GT from the two lists, then click the Add Link button. For this project, connect the
following links (Figure 1-18).

e MGT_X1Y8/TX to MGT_X1Y8/RX
e MGT_X1Y9/TX to MGT_X1Y9/RX
e MGT_X1Y10/TX to MGT_X1Y10/RX
e MGT_X1Y11/TX to MGT_X1Y11/RX
#i, Create Links |£
@ To create a new link select a TX GT and/for an RX GT, then press the Add Link button,
TX GTs RX GTs
Search: | Q- Search: | Ci~ |
MGT_X1Y8/TX (xc7ux485t_1/Quad_115) MGT_X1Y8/RX (xcTvx485t 1/Quad_115)
[+ MGT_X1Y9/TX (xc7vx485t_1/Quad_115) <A MGT_X1Y9/RX (xc7vx485t_1/Quad_115)
[ MET_X 17 10/T% (x 135t _1/Quad_115) <H] MGT_¥1Y10/R¥ (xc7vx435t_1/Quad_115)
[ MGT_X1Y11/TX (xc7vx485t_1/Quad_115) <A MGT_X 1Y 11/RX (xcTvx435t_1/Quad_115)

Mew Links

Description TX RX

| Delete Links

Create link group
Link group description: Link Group 0
Open Serial If/Q Analyzer layout

UG847_c1_18_031014

Figure 1-18: Create Links Window
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& XILINX. Running the GTX IBERT Demonstration

Viewing GTX Transceiver Operation

After completing step 6 in Starting the SuperClock-2 Module, the IBERT demonstration is
configured and running. The status and test settings are displayed on the Links tab in the
Links window shown in Figure 1-19.

Note the line rate and error count:

e The line rate for all four GTX transceivers is 12.5 Gb/s (see Status in Figure 1-19).

¢ Verify that there are no bit errors.

File Edit Flow Tools Window Layout View Help Search commands

AR o2 X %K E |5 serial 1/0 Analyzer P & B2

Hardware Manager - localhost/xilinx_tcf/Digilent/210251809763 x
Hardware —Owe = Debug Probes —Ouw x (53 VIO - hw_vio_1 X 0 X
QA= EFE & bR o= =E 2| | vio Probes A Ox%
Name Status - hw_vie_1 ~ | B3] | O Name Value Activity  Direct
- : u_scmqu_\r!n_sg:;_cnn:n:ﬂi_:da E‘p E - u_scm2fu_vio_sclk2_control/si5368_freq[19:0] [U] 156250 Input
i E_:a;ffz_\\::z_:dkz_is:h-;:Zc_rdnndEata[7-0] = u_scm2fu_vio_sck2_controlfsi570_freq[19:0] [U] 156250 Input
: - = — - B =

u_scm2fu_vio_sck2_controlfsi5368_addr[6:0] [U] 80 ~ Qutpur
u_scm2fu_vio_sck2_controlfsi570_addr[6:0] [U] &0 w Qutpur

%5 u_sem2fu_vio_sdk2_controlfpca0_ctrl_1[5:0] w

Locked i u_scm2fu_vio_sdk2_controlfpcal_ctrl_1[5:0] U_scm2/u_vie_sdka_control 55358 start Elo ~ Outpu
12,500 Gbps i %5 u_scm2fu_vio_sdk2_controlfsdk_in[8:0] Ell i-la u_sem2fu_vio_sck2 control/si570._start Elo = Outpur
12,500 Gbps = i u_scm2fu_vio_sdk2_controlfsck_out_1[5:0] - - - -
12,500 Gbps +elg U_scm2fu_vio_sdk2_control/si5368_done
12.500 Gbps L #-%8 u_scm2ju_vio_sck2_control/si5368_freq[19:0]
oK - +lg U_scm2fu_vio_sdk2_control/si570_done F
< L= -5 u_sam2fu_vio_scdk2_control/si570_freq[19:0]
-5 u_scm2fu_vio_sdk2_control/i2c_dev_addr[7:0]
[BERT Core Properties -oe = +la u_sem2fu_vio_sdk2_controlfi2c_noreg
+& » R.-? RT (-5 u_scm2fu_vio_sdk?_controlfi2c_reg_addr[7:0]

+-La u_sem2fu_vio_sclk2_controlfi2c_start

[-%g u_sem2fu_vio_sdk?2_controlfi2c_wr_data[7:0]
. %5 u_sem2fu_vio_sdk2_controlfpca0_ctrl[5:0]
Mame: localhost/xilink_tcf/Digilent/210251809763/1_1/IBERT 45 u_scm2/u_vio_sdk?_contraljpeal_ciri[s:0]
Device: - la u_sem2fu_vie_sdk2_contralfsdk2_reset

g u_scm2fu_vio_sdk2_control/sclk_out[5:0] L
[#-%5 u_scm2fu_vio_sck2_controlfsi5368_addr[6:0]

[#-%5 u_scm2fu_vio_sck2_controlfsi5368_dkin[1:0]

tela U_scm2fu_vio_sdk2_control/siS368 _ckwr

$E [BERT

%5 u_sem2ju_vio_sdk2_control/si5368_dsbi[4:0] . < i Q=)

General | Properties | GT Groups ela u_sem2fu_vio_sdk2_controlfsi5368_reset =

Serial IfO Links — 0O 2 x
| Name T RX Status Bits Errors TX Pattern RX Pattern TX PreC... TXPost-.. TXDiffSwing TXReset RXReset RXPL.. TXPLL...
Z = Ungrouped...
g PRBS 31-hit = PRBS 31-bit * 1.67d.. ¥ 0.68... = 1018mV(1L.. ~ Reset Reset
- MGT_X1Y8/TX MGT_x1Y3/Rx |12.500 Gbps| 3.39E1 0ED| PRBS 31-hit = PRBS 31-bit * 167d.. * 0.68... = 1018mV(1L.. ~ Reset Reset locked  Locked
MGT_X179/TX MGT_x1Y39/Rx |12.500 Gbps| 3.393E1 0ED| PRBS 31-hit = PRBS 31-bit * 1.67d.. ¥ 0.68... = 1018mV(1L.. ~ Reset Reset locked Locked
\ﬁ’ MGT_X1710/TX MGT_x1Y10/RX |12.500 Gbps| 3.397E1 0ED| PRBS 31-hit = PRBS 31-bit * 167d.. * 0.68... = 1018mV(1L.. ~ Reset Reset locked  Locked

- MGT_X1Y11/TX MGT_x1Y11/RX |12.500 Gbps| 3.399E1 OED| PRBS 31-bit + PRBS 31-bit v~ 1.67d... v 0.68... = 1018mV(11.. ~ Reset Reset locked Locked

@

-
:D | 1 =

|2 Tl Console | (O Messages . “%, Serial I/0 Links | [5] Serial 1/0 Scans
UGB47_c1_19_090914

Figure 1-19: Serial I/O Analyzer Links
In Case of RX Bit Errors

If there are initial bit errors after linking, or as a result of changing the TX or RX pattern,
click the respective BERT Reset button to zero the count.

If the MGT Link Status shows No Link for one or more transceivers:

* Make sure the blue elastomer seal is connected to the bottom of the BullsEye cable and
the cable is firmly connected and flush on the board.

* Increase the TX differential swing of the transceiver (to compensate for any loss due to
PCB process variation)

e (lick the respective TX Reset button followed by BERT Reset (Figure 1-19).
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Additional information on the Vivado Design Suite software and IBERT core can be found
in Vivado Design Suite User Guide: Programming and Debugging (UG908) [Ref 3] and
LogiCORE IP Integrated Bit Error Ratio Tester (IBERT) for 7 Series GTX Transceivers Product
Guide for Vivado Design Suite (PG132) [Ref 4].

Closing the IBERT Demonstration
To stop the IBERT demonstration:
1. Close the Vivado Design Suite application by selecting File > Exit.

2. Place the main power switch SW1 in the off position.

SuperClock-2 Frequency Table

Table 1-2 lists the addresses for the frequencies that are programmed into the SuperClock-2
read-only-memory (ROM).

Table 1-2: Si570 and Si5368 Frequency Table

Address Protocol Fr?'c\|nt||_lezr;cy Address Protocol Fr?ﬁntl{lezr)\cy Address Protocol Fr?'?nthezr)ncy
0 100GE/40GE/10 1 161130 30 OBSAI 307.200 60 XAUI 156.250
1 Aurora 81.250 31 OBSAI 614.400 61 XAUI 312.500
2 Aurora 162.500 32 0OC-48 19.440 62 XAUI 625.000
3 Aurora 325.000 33 0OC-48 77.760 63 Generic 66.667
4 Aurora 650.000 34 0OC-48 155.520 64 Generic 133.333
5 CE111 173.370 35 0OC-48 311.040 65 Generic 166.667
6 CPRI 61.440 36 OC-48 622.080 66 Generic 266.667
7 CPRI 122.880 37 OTU-1 166.629 67 Generic 333.333
8 CPRI 153.630 38 OTU-1 333.257 68 Generic 533.333
9 CPRI 245.760 39 OTU-1 666.514 69 Generic 644.000
10 CPRI 491.520 40 OTU-1 666.750 70 Generic 666.667
11 Display Port 67.500 41 OTU-2 167.330 71 Generic 205.000
12 Display Port 81.000 42 OTU-2 669.310 72 Generic 210.000
13 Display Port 135.000 43 OTU-3 168.050 73 Generic 215.000
14 Display Port 162.000 44 OTU-+4 174.690 74 Generic 220.000
15 Fibrechannel 106.250 45 PCle 100.000 75 Generic 225.000
16 Fibrechannel 212.500 46 PCle 125.000 76 Generic 230.000
17 Fibrechannel 425.000 47 PCle 250.000 77 Generic 235.000
18 GigE 62.500 48 SATA 75.000 78 Generic 240.000
19 GigE 125.000 49 SATA 150.000 79 Generic 245.000
20 GigE 250.000 50 SATA 300.000 80 Generic 250.000
21 GigE 500.000 51 SATA 600.000 81 Generic 255.000
22 GPON 187.500 52 SDI 74.250 82 Generic 260.000
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& XILINX.

SuperClock-2 Frequency Table

Table 1-2: Si570 and Si5368 Frequency Table (Contd)

Address Protocol Frtznqnlll_'ezr)lcy Address Protocol Fr((alc\]nl:'ezr)\ cy Address Protocol Frtz'?nlll_'ezr)lcy
23 Interlaken 132.813 53 SDI 148.500 83 Generic 265.000
24 Interlaken 195.313 54 SDI 297.000 84 Generic 270.000
25 Interlaken 265.625 55 SDI 594.000 85 Generic 275.000
26 Interlaken 390.625 56 SMPTE435M 167.063 86 Generic 280.000
27 Interlaken 531.250 57 SMPTE435M 334.125 87 Generic 285.000
28 OBSAI 76.800 58 SMPTE435M 668.250 88 Generic 290.000
29 OBSAI 153.600 59 XAUI 78.125 89 Generic 295.000
90 Generic 300.000 103 Generic 365.000 116 Generic 430.000
91 Generic 305.000 104 Generic 370.000 117 Generic 435.000
92 Generic 310.000 105 Generic 375.000 118 Generic 440.000
93 Generic 315.000 106 Generic 380.000 119 Generic 445.000
94 Generic 320.000 107 Generic 385.000 120 Generic 450.000
95 Generic 325.000 108 Generic 390.000 121 Generic 455.000
96 Generic 330.000 109 Generic 395.000 122 Generic 460.000
97 Generic 335.000 110 Generic 400.000 123 Generic 465.000
98 Generic 340.000 111 Generic 405.000 124 Generic 470.000
99 Generic 345.000 112 Generic 410.000 125 Generic 475.000
100 Generic 350.000 113 Generic 415.000 126 Generic 480.000
101 Generic 355.000 114 Generic 420.000 127 Generic 485.000
102 Generic 360.000 115 Generic 425.000
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Chapter 1: VC7203 IBERT Getting Started Guide

& XILINX.

Creating the GTX IBERT Core

Vivado Design Suite 2014.4 is required to rebuild the designs shown here.

This section provides a procedure to create a single Quad GTX IBERT core with integrated
SuperClock-2 controller. The procedure assumes Quad 113 and 12.5 Gb/s line rate, but

cores for any of the GTX Quads with any supported line rate can be created following the
same series of steps.

For more details on generating IBERT cores, refer to Vivado Design Suite User Guide:

Programming and Debugging (UG908) [Ref 3].
1. Start the Vivado Design Suite.

2. In the Vivado design tools window;, click the Manage IP icon (highlighted in

Figure 1-20), then select New IP Location.

File Flow Tools Window Help

Quick Start
A\

Q

Create Mew Project

Tasks

Manage IP

Information Center

Documentation and Tutorials

£
i,f.t

Open Project

Open Hardware Manager

Quick Take Videos

VIVADO? o v

Wi

Open Example Project

Nilinx Tdl Store

Release Notes Guide

£ XILINX

ALL PROGRAMMABLE.

2 Td Console

Figure 1-20: Vivado Design Suite Initial Window

UGBA47_c1_20_051314

3. When the Create a New Customized IP Location dialog window opens (not shown),
click Next.
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& XILINX. Creating the GTX IBERT Core

4. Inthe Manage IP Settings window, select a part by clicking the (...) button next to the
Part field. A Select Device window pops up. Use the drop-down menu items to narrow
the choices. Select the xc7vx485tffg1761-3 device (Figure 1-21). Click OK.

Filter, search, and browse parts by their resources. The selected part or board will be applied.

Select: E Boards

4 Filter
Product category: | All - Package: ffg1761 -
Eamily: Virtex-7 - Speed grade: | -3 -
Sub-Family: All Remaining - Temp grade: | All Remaining -
Reset All Filters ]
Search: | O
I/0 Pin Available LuT i Block Gh
e Cournt I0Bs Elements e RAM= i Transcei
i xcTv5e5tfg1761-3 1,751 850 394200 728400 795 1260 38

@ xc7vx330tffg1761-3 1,761 204000 403000 750

- XCPvxaBStfgl1751-3 |1,751

433200

‘< ] =

K H Cancel ]

UG847_c1_21_090914

Figure 1-21: Select Device
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Chapter 1: VC7203 IBERT Getting Started Guide

& XILINX.

5. Back on the Manage IP Settings window, select Verilog for Target language, Vivado

Simulator for Target simulator, Mixed for Simulator language, and a directory to save
the customized IP (Figure 1-22). Click Finish.

Manage IP Settings
Set options for creating and generating IF.

Part: G xcTvx485tfg1761-3 (active)
Target language: Verilog

Target simulator: Vivado Simulator

Simulator language: | Mixed

IP location: C:NCT203

Figure 1-22:

Next = [ Einish ] [ Cancel

UG847_c1_22_090914

Manage IP Settings
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& XILINX.

Creating the GTX IBERT Core

6.

In the Vivado IP Catalog window, open the Debug & Verification folder, then open the

Debug folder, and double-click IBERT 7 Series GTX (Figure 1-23).

e

E

X
O

s
®

Search: | Ci-
Mame AXI4 Status License

[#-[= alliance Partners

[ Automotive & Industrial

[ AXI Infrastructure

[~ BaseIP

[= Basic Elements

(= Communication & Networking

=7 Debug & Verification

- Debug

-4 IBERT 7 Series GTH Induded

m Induded
¥ IBERT 7 Series GTX |F'roducﬁor1 |Ir1duded
4F IBERT 7 Series GTZ Induded

-4 IBERT Ultrascale GTH Induded

4k IBERT Ultrascale GTY Incuded

{F ILA (Integrated Logic Analyzer) AXI4, AXI4-Stream Production Induded

{F ITAG to AXI Master AXI4 Production Induded

1F vI0 (Virtual Input/Output) Production Induded

H-[= Digital Signal Processing

t-[= Embedded Processing

H-(= FPGA Features and Design

H-[= Math Functions

t-[= Memories & Storage Elements

H-(= Standard Bus Interfaces
4 10

9@ B L o |k |

(|| &

[ O o IO A o A

VL

ilir
ilir)
eciie
ilir|
ilir|
ilir|
ilir
ilir
ilir,

| »

m

I

UG847_c1_23_102914

Figure 1-23: IP Catalog
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Chapter 1: VC7203 IBERT Getting Started Guide

& XILINX.

7. A Customize IP window opens. In the Protocol Definition tab, change
LineRate (Gbps) to 12.5, then use the drop-down to change the Refclk (MHz) to
156.250. Keep defaults for other fields (Figure 1-24).

IBERT 7 Series GTX (3.0)

ﬁﬁ Documentation |5 IP Location (gl Switch to Defaults

[ Show disabled ports

RAN_I3:0]

RAP_I[3:0] THH_C[3:0] b
GTREFCLKO_I0:0]  THP_o[%:0] »

GTREFCLEL_I[0:0]  RMOUTCLE O
SYSCLK_T

Component Name | bert_Fseries_gtx_0

Protocol Definition | Protocol Selection | Clock Settings | Summary

Silicon Version
@ General ES/Productiont
() Initial ES
The maximum number of quads available for this device is 7
MNumber of Protocols L3 ot
Protocol DataWidth Refdk{MHz) Quad Count Quad PLL
Custom 1 - |155. 250 - |1 - &
o)

UGBA47_c1_24_090914

Figure 1-24: Customize IP - Protocol Definition
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& XILINX. Creating the GTX IBERT Core

8. In the Protocol Selection tab, select Custom 1/ 12.5 Gbps in the drop-down menu
under Protocol Selected next to QUAD_113, and select MGTREFCLK1 113 in the
Refclk Selection drop-down menu (Figure 1-25).

IBERT 7 Series GTX (3.0) '

ﬁj Documentation [ IP Location [ Switch to Defaults

[ Show disabled ports Compenent Mame | ibert_7series_ghx_0
- " Protocol Definition- Protocol Selection | 'ClockSemngs' Summary |

Please select Protocol-Quad combination

GTX Location Protocol Selected Refidk Selection THUSRCLK Source
|QuAD_113 Custom 1/ 12.5 Gbps ~ MGTREFCLKD 113 ~ Channel 0 - |
QUAD_114 None ~ None ~ Channel 0 -
QUAD_115 None ~+ Mone + Channel 0 -
QUAD_116 None ~ MNone ~ Channel 0 -
QUAD_117 MNone ~ Hone ~ Channel 0 -
QUAD_113 None + MNone ~ Channel 0 -
Rk _I[3:0] | QUAD_119 None ~ Mone + Channel 0 -

RAP_I3:0]
GTREFCLKO_I[0:0]

GTREFCLKD_I[0:0]
SYSCLK_I

UG847_c1_25_090914

Figure 1-25: Customize IP - Protocol Selection
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Chapter 1: VC7203 IBERT Getting Started Guide & XILINX.
In the Clock Settings tab, select DIFF SSTL15 for the I/O Standard, enter E19 for P
Package Pin and E18 for N Package Pin (the FPGA pins that the system clock connects
to), and make sure the Frequency is set to 200.00 (Figure 1-26). Press OK. A Generate
Output Products window opens. Leave the defaults unchanged, and press Generate.
IBERT 7 Series GTX (3.0) ‘
ifg Documentation [ IP Location (3} Switch to Defaults
[7] Show disabled ports Component Name | ibert_7series_gtx_0
- Protocol Definition Protocol Selection” Clock Settings | Summary
RXOUTCLK Probe
[T Add RXOUTCIK Probes
Clock Type Source 1/0 Standard P Package Pin M Package Pin Frequency(MHz)
System Clock External - ']IFF SSTL15 ~ |E19 E18 200.00 I
System Clock Termination Settings
[] Enable DIFF Term
M _1[3:0]
Rep_I[3:0] T¥N_0[3:0]
GTREFCLED_I[0:0]  TRP_0[3:0]
GTREFCLEL_I[0:0]  RECUTCLK_O
SYSCLE T
Cancel
UG847_c1_26_090914
Figure 1-26: Customize IP - Clock Settings
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& XILINX. Creating the GTX IBERT Core

10. Back to Manage IP, in the Sources window, right-click the IBERT IP and select Open IP
Example Design (Figure 1-27). Specify a location to save the design, press OK, and the
design opens in a new Vivado design tools window.

Project Manager - xcFvx425tffg1761-3

Sources — O @ = Jﬂ:IPCatalug X |
O\r_1'-_-'| Oﬁl. pd Search: | O
E-= 1P (1) = £1
- e : 29 | Name
|  Source File Properties. .. Ctrl+E |-[= Alliance Partners
¥ Re-customize IP... [ Automotive & Industrial
(= AXI Infrastructure
Generate Output Products. .. [ BaselP
Reset Qutput Products. .. (= Basic Elements
Out-of-Context Settings... [ Communication & Metworking
B (= Debug & Verification
Jpgrade I E--[= Debug
Copy IP... - 4F IBERT 7 Series GTH
®  Open IP Example Design. .. -~ 4F IEI:RT 7 Series GTF
IF Documentation G -4 IBERT 7 Series GTZ
Cony Shared Logic ints Project - 4F IBERT Ultrascale GTH
P <o 3 Report IP Stat --F IBERT Ultrascale GTY
u & Epar = -4F ILA (Integrated Logic Analyzer)
P — ¥ Remove IP from Project... Delete --4F JTAG to AXI Master
- I -4F VIO (Virtual Input/Output)
2 RE}| b I -(= Digital Signal Processing
{F ibert_7series_gbx_0.xd SetUsedIn... [ Embedded Processing .
@ AddExistng IP... = FPGA feat&lres and Design
IP name: IBERT 7 Series GTX =l | L]

UGB47_c1_27_090914

Figure 1-27: Open IP Example Design
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Chapter 1: VC7203 IBERT Getting Started Guide & XILINX.

11. In the new window, select Tools > Run Tcl Script. In the Run Script window, navigate
to add_scm2.tcl in the extracted files and press OK. The SuperClock-2 Module
Design Sources and Constraints are automatically added to the example design
(Figure 1-28).

:. Project Manager - ibert_7Yseries_gtx_0O_example

I
X

SOUrces ]

QA T=|mct R
@ Design Sources (4)
Wi gw example_ibert_7series_gitx_0 iexample_ibert_7series_gtx_ 0o (1)
L {Fu_ibert_core - ibert_7series_gtx_0 (iber_7series_gtx_0.xci)
B top_scmd fdop_som2 o (2]
l;.y_é- u_freq_counter - freq_counter (freq_counter.y)
w8 U _win_sclk2 _control - wio_sclk2 _control fvo_sclk2 _control s (20
1 Text (23

@ Constraints (2)
©—= constrs_1 (2)

% example_ibert_7series_gty_0 xdc

% top_scm2 . wdc
@~ Simulation Sources (4)

Hierarchy [P Sources Libraries Compile Order

& Sources | T Templates

UG847_c1_28_030314

Figure 1-28: Sources after Running add_scm2.tcl
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& XILINX.

Creating the GTX IBERT Core

12. The SuperClock-2 source code now needs to be added to the example IBERT wrapper.

Double-click example_ibert_7series_gtx_0 in Design Sources to open the Verilog
code. Add the top level ports from top_scm2.v to the module declaration and

instantiate the top_scm2 module in the example IBERT wrapper (Figure 1-29). Click
File > Save File.

example_ibert_7series_gtx_0.v

— O &1 =

= 1 NCT203 fibert_Tseries_ghx_0/ibert_Fseries_gtx_0_examplefibert_Fseries_gtx_0_example.srcsfsour

B

¢ 2] @ <0 | W & | &

21 module example_ ibert Tseries_gtx 0

22 (

L = L

[E= S T SR SRS S S
[= TR

(&)

output [ (4* C_NU

TEN_ O,
output [ (4* C_NU : TXE O,
input [({4* C_NUM QURDS)-1:0] REN I,
input [ {4* C_NUM_QUA RXF I,
input SYSCLKF I,
input SYSCLEN I,
input ["C_REFCLES USED-1:0] GIREFCLEOF I,
input ["C_REFCLES_TUSED-1:0] GIREFCLEON_I,
input ["C_REFCLES_USED-1:0] GIREFCLELP I,
input ["C BEFCLES USED-1:0] GIBEFCLELIN I,

T
i
i

I,

<
I

T
m
F

I
[
[

input [2:0] usrclk p
input [2:0] usrclk n,
inout iZe sda,

inout iZc scl,

output [5:0] sclk_out,
input [&:0] sclk_in,
ocutput [1:0] sclk_clk_p,
output [1:0] sclk_clk_n

43

wire
wire
wire

wire
wire

gtrefclk0_i:

gtrefclkl i;
refclk0_i;
refclkl i;

aysclk_i;

top sScm2 u_scm2
(

.3yaclk_i(sysclk i),
.usrclk_p(usrclk p),
.usrclk n{usrclk nj,
.i2c_sda(iZc_ada),
.12c_s3cl{iZc_scl),
.3clk_out(sclk_out),
.3clk _in(sclk in),
.3clk_clk pisclk_clk_p),
.3clk_clk n(sclk_clk_n)

3

-

m

UGB47_c1_29_090914

Figure 1-29: SuperClock-2 in the Example IBERT Wrapper
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13. In the Sources window, Design Sources should now reflect that the SuperClock-2
module is part of the example IBERT design (Figure 1-30).

Project Manager - ibert_Tseries_gtx_0_example

M
#

Sources — O
A== weh BIE

{= Design Sources (3]

=18 4w example_ibert_7series_gbx_0 [=xample_ibert_Tseries_ghe 0]
(-8 u_scm?2 - top_scm2 (top_scm2.v) (2)

(@8 u_freq_counter - freq_counter (freq_counter.v)

=+-@# u_vio_sdk?_control - vio_sdk2_control (vio_sdk2_contral.v) (3)

----- {FEu_viol - vio_scm2 (vio_scm 2. xci)

e w8 u_i2c_scdk?_control -i2c_sdk2_control (i2c_sck2_control_bhb
effiu_i2c_sdk2_control -i2c_sdk?_control {i2c_sdk?_control.ng
4 Fu_ibert_core -ibert_7series_gtx_0 (ibert_7series_ghx_0.xc)

= Text (2)

i) Constraints (2)

= Simulation Sources (3)

Il";']' Properties I

| 1 [ » [O
IF Sources |Libraries |Cum|:u'le Order |

ih Sources L ' Templates ]

UG847_c1_30_031014

Figure 1-30: Design Sources File Hierarchy
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& XILINX. Creating the GTX IBERT Core

14. Click Run Synthesis in the Flow Navigator to synthesize the design (Figure 1-31).

4 Project Manager
% Project Settings
:;;.'4}7 Add Sources
1F IP Catalog

IF Integrator
Simulation
RTL Anahysis

4 Hmthesis

{3 synthesis Settings

$ Eun Synthesis

i® Open Synthesized Design

Implementation

Program and Debug

UG847_c1_31_032714
Figure 1-31: Project Manager Window

15. When synthesis is done, a Synthesis Complete window opens. Select Open
Synthesized Design and click OK (Figure 1-32).

6, Synthesis successfully completed.

et

) Eun Implementation

8 [Dpen Synthesized Design|

() Wiew Repaorts

[ ] Don't show this dialog again

|| OF, |,| | Cance|

UGB47_c1_32_032714

Figure 1-32: Synthesis Completed
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16. When the Synthesized Design opens, select dbg_hub in the Netlist window, then
select the Debug Core Options tab in the Cell Properties window and change
C_USER_SCAN_CHAIN* to 3 (Figure 1-33). Click File > Save Constraints.

Synthesized Design * - synth_1 | xc?vxddstifig1761-3 (active)
Metlist

sl

3+ example_ibert_Tseries_gtw_0

-5 Nets |
e

O

M
®

=
25 ]

4 =i
)

i u_ibert_core (jbert_7
&-{8] u_scm2 (top_scm2)

&% Sources. (3] Metlist

Cell Properties

« + BB

¥ dbg_hub

C_USER_SCAN_CHAIN®
C_CLK_INPUT_FREQ HZ
C_ENABLE_CLK_DIVIDER

E ]

300,000,000

=

Select an option above to see a description of it

Gereral | Properties | Debug Core Options | Debug Ports | Statisth 4 p B

UG847_c1_33_090914
Figure 1-33: Dbg_hub Debug Core Options

17. In the Flow Navigator under Program and Debug, click Generate Bitstream

(Figure 1-34). A window pops up asking if it is okay to launch implementation. Click
Yes.

Mo Implementation Results Available [=2 ]

"-I There are no implementation results available. Ok to [aunch implementation? 'Generate
P Bitstream’ will automatically start when implementation completes,

[] Don't show this dialog again

Yes |

No |

UGB47_c1_34_090914

Figure 1-34: Generate Bitstream
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& XILINX. Creating the GTX IBERT Core

18. When the Bitstream Generation Completed dialog window appears, click Cancel
(Figure 1-35).

Bitstrearn Generation Completed @

i@ Open Implemented Design

() View Reports

(71 Open Hardware Manager

[] Dor't show this dialog again

UG847_c1_35_051314

Figure 1-35: Bitstream Generation Completed

19. When the bitstream generation completes, navigate to the project directory and locate
the generated bitstream file. When implementation completes, navigate to:
\ibert_7series_gtx_0O\ibert_7series_gtx_0_example\ibert_7series_
gtx_0_example.runs\impl_ 1 directory to locate the generated bitstream.
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& XILINX.
Appendix A

Additional Resources

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see the
Xilinx Support website.

For continual updates, add the Answer Record to your myAlerts.

Solution Centers

See the Xilinx Solution Centers for support on devices, software tools, and intellectual
property at all stages of the design cycle. Topics include design assistance, advisories, and
troubleshooting tips.

References

The most up to date information related to the VC7203 kit and its documentation is
available on these websites.

Virtex-7 FPGA VC7203 Characterization Kit
Virtex-7 FPGA VC7203 Characterization Kit documentation
Virtex-7 FPGA VC7203 Characterization Master Answer Record (AR 52383)

These Xilinx documents and sites provide supplemental material useful with this guide:

1. VC7203 Virtex-7 FPGA GTX Transceiver Characterization Board User Guide (UG957)

2. HW-CLK-101-SCLK2 SuperClock-2 Module User Guide (UG770)

3. Vivado Design Suite User Guide: Programming and Debugging (UG908)

4. LogiCORE IP Integrated Bit Error Ratio Tester (IBERT) for 7 Series GTX Transceivers Product

Guide for Vivado Design Suite (PG132)
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& XILINX.
Appendix B

Warranty

THIS LIMITED WARRANTY applies solely to standard hardware development boards
and standard hardware programming cables manufactured by or on behalf of Xilinx
(“Development Systems”). Subject to the limitations herein, Xilinx warrants that
Development Systems, when delivered by Xilinx or its authorized distributor, for ninety
(90) days following the delivery date, will be free from defects in material and
workmanship and will substantially conform to Xilinx publicly available specifications for
such products in effect at the time of delivery. This limited warranty excludes:

(i) engineering samples or beta versions of Development Systems (which are provided
“AS IS” without warranty); (ii) design defects or errors known as “errata”;

(iii) Development Systems procured through unauthorized third parties; and

(iv) Development Systems that have been subject to misuse, mishandling, accident,
alteration, neglect, unauthorized repair or installation. Furthermore, this limited warranty
shall not apply to the use of covered products in an application or environment that is not
within Xilinx specifications or in the event of any act, error, neglect or default of Customer.
For any breach by Xilinx of this limited warranty, the exclusive remedy of Customer and
the sole liability of Xilinx shall be, at the option of Xilinx, to replace or repair the affected
products, or to refund to Customer the price of the affected products. The availability of
replacement products is subject to product discontinuation policies at Xilinx. Customer
may not return product without first obtaining a customer return material authorization
(RMA) number from Xilinx.

THE WARRANTIES SET FORTH HEREIN ARE EXCLUSIVE. XILINX DISCLAIMS ALL
OTHER WARRANTIES, WHETHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, OR NON-INFRINGEMENT, AND ANY WARRANTY THAT
MAY ARISE FROM COURSE OF DEALING, COURSE OF PERFORMANCE, OR USAGE
OF TRADE. (2008.10)

Do not throw Xilinx products marked with the “crossed out wheeled bin” in the trash.
Directive 2002/96/EC on waste electrical and electronic equipment (WEEE) requires the
separate collection of WEEE. Your cooperation is essential in ensuring the proper
management of WEEE and the protection of the environment and human health from
potential effects arising from the presence of hazardous substances in WEEE. Return the
marked products to Xilinx for proper disposal. Further information and instructions for
free-of-charge return available at: www.xilinx.com\ehs\weee.htm.
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